
 
 

 

Castor-ELEC 
Version 5.0 – Electromagnetic pollution  

 
Electrosmog · Mobile phone towers · Software  

 
 

MANUAL  
 
 

 
 
 

Castor  
Environmental Software, C.P.  

28034 Madrid, Spain 

info@environmental-impact.eu 
 
 
 

 

 Printed on recycled paper. 



Castor . 
 

 II 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
© 00/2004/2150 
 
© Copyright 2001 Protected by copyright law and international treaties. 
Unauthorized reproduction or distribution subject to severe civil and criminal 
penalties. 
 
 
 
 



                                                                                                                                                                  
CastorELEC 

III 

 

 
 

IMPORTANT. READ ATTENTIVELY 
 

CASTOR SOFTWARE CASTOR-ELEC FOR WINDOWS 95 
 
 
This License agreement for the End user of an application carried out by Castor 
Environmental Software (Castor Environmental Software) constitutes a legal 
agreement among you (either a person or an entity) and Castor Environmental 
Software regarding the software of Castor Software that includes the software and 
other related means, the printed materials (as the user's manual) and any other 
documentation (software). If you install, or you copy or you use this software or 
the user's manual, you accept the terms of the present License agreement for the 
End user. If you don't agree with the terms of this License agreement for the End 
user, don't install or use this product software and their related means; and 
return it where you acquired it.  
 
 
 

LICENSE OF SOFTWARE 
 
The software is protected by author's laws, by international treaties on copyright 
and by other laws and treaties on the intellectual property. The software carried 
out by Castor Environmental Software is allowed to use with license, it is not 
sold.  
 
Concession of License, The License agreement for the End User grants the following 
rights: 
 

 Software of Applications.- You will be allowed to install and to use a copy 
of the software in a PC. The main user of the PC will be able to make a 
second copy for his exclusive use in a portable PC. 

 
 Storage and use in the net.- You will also be allowed to install or to store 

a copy of the software in a storage device just as a network server.  
 

 However, you will acquire a license for each PC in which you can execute the 
software. You won't be allowed to share neither to use simultaneously in 
different PCs a license for the software. 

 
 Software not for sale.- It is not allowed to resell, or to transfer, for any 

money the software. 
 
 
Other rights and limitations. 
 

 It is not allowed to use technical of inverse engineering. 
 

 The software is granted with license as a unique product. Their components 
cannot separate to be used in more than a PC. 

 
 It is not allowed to rent or to lend the software. 

 
 All the rights shown in the License agreement for the End user can only be 

transferred with the condition that the receiver accepts the terms of this 
License agreement for the End user. 

 
 Without prejudice of any other right, Castor Environmental Software can 

finish this License agreement for the End user if you don't fulfill the terms 
and conditions of the contract. In this case, you will destroy all the copies 
of the product software and their components. 
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Copyright:  The ownership and copyright with regard to the software, the printed 
materials that accompany it and any copy of the product software is property of 
Castor Environmental Software. The software is protected by copyright laws and by 
international treaties. Consequently, you will try to the software like any other 
material subject to copyright with the difference that you will be allowed to 
install the software in a single PC. It is not allowed to copy the printed 
materials that accompany to the software. 

****** 
 

The parties to this agreement are Castor Environmental Software, hereinafter 
referred to as "Castor Environmental Software" the CASTOR-ELEC Software user 
hereinafter referred to as "Licensee." 
 
EFFECTIVE DATE: This agreement shall take effect upon execution. 
 
LICENSED MATERIALS: Castor Environmental Software hereby grants to Licensee one (1) 
non-exclusive, non-transferable, and royalty-free license to install the Licensed 
CASTOR-ELEC system (application and user’s manual) on one computer, which is 
incorporated herein by reference. One computer is defined as one unique combination 
of Operating System(OS)/ Processor(CPU) / Hard Drive(HD). 
 
LICENSE PROVISIONS: Castor Environmental Software shall have no obligation to 
provide support, including but not limited to installation, maintenance, debugging 
and improvements, for Licensed Materials, except as Castor Environmental Software 
at its sole discretion, shall determine to be reasonable. Licensee agrees to make 
available to Castor Environmental Software any modifications or enhancements to the 
Licensed Materials provided under this agreement. Castor Environmental Software 
shall have the right to use such modifications and enhancements for any purpose 
whatsoever. 
 
NOTICES: Any notices required to be given or which shall be given under this 
agreement shall be in writing delivered by first-class mail. Notices shall be 
addressed to the parties as follows: 
 

License Manager 
Castor Environmental Software 

 
WARRANTIES: Licensee agrees to accept the Licensed Materials on an "as is, with all 
defects" basis. Castor Environmental Software makes no warranties, express, implied 
in law or in fact, including any implied warranty of merchantability or fitness for 
a particular purpose, or results obtained from Licensee's use of Licensed 
Materials, or that the use of any Licensed Materials will not infringe on any 
patent, copyright or trademark or other rights. 
 
LIABILITY AND INDEMNIFICATION:  Castor Environmental Software shall not be liable 
for any manner of loss or damage arising out of the use of  the materials provided 
hereunder. Further, Castor Environmental Software shall not be obligated to 
indemnify the Licensee in any manner for any loss which Licensee may experience, of 
any kind or nature, arising out of the use of the materials. 
 
ASSIGNMENT: This agreement shall inure to the benefit of and be binding upon the 
parties, and their respective successors and assigns. This agreement shall not be 
assigned by either party without the written consent of the other party thereto. 
 
GOVERNING LAW: This agreement shall be interpreted, enforced and construed 
according to the laws of the Kingdom of Spain (Santa Cruz de Tenerife). 
 
ENTIRE AGREEMENT: This agreement contains the entire agreement between the parties 
with respect to the subject matter hereof, and it shall not be modified or amended 
except by an instrument in writing signed by both parties hereto. 
 
 

Castor Environmental Software 
info@canarina.com
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DISCLAIMER 
 
 The present document has been carried out by Castor Environmental 
Software,SLU in its entirety. Any mention that we can find in the manual of 
companies, official organisms, names, products or trademarks don't imply the 
participation of these in the realization of the present document neither in the 
development of the software. On the other hand, the mention that we can find in the 
manual of companies, official organisms, trade names, products or trademarks don't 
mean that they are recommended by Castor Environmental Software, SLU. The 
information contained in this document has been obtained by Castor Software of 
credible sources. Nevertheless, Castor Software doesn't guarantee the accuracy or 
perfection of the published information. Castor Software won't become responsible 
for any error, omission or damage caused by the use of the information of the 
manual present and of the software. With the use of the software and manual, Castor 
Software is not providing any specific professional service to carry out technical 
studies. Specialized professionals, hired for this, will carry out the pertinent 
studies. 
 
 The CASTOR-ELEC software estimates the electromagnetic pollution in the air. 
These types of numeric simulations are a method to estimate the contamination in an 
approximate way. Castor Software doesn't guarantee that the results obtained by 
this program coincide with the real concentrations that we can find in the air. The 
software, the used algorithms and the manual have been conscientiously examined of 
the possible existence of errors or omissions. Although we have checked the 
operation of CASTOR-ELEC keeping in mind the results that we can find in the 
existent scientific literature on the area, Castor Software is not responsible for 
errors or omissions that we can find in the software, in the used calculation 
algorithms and in this manual. Castor Software is not responsible for losses or 
damages caused by the use of this software or of the user's manual. This software 
has been conscientiously examined of the possible existence of computer virus 
before its distribution.  
 

Although we have used programs up-to-date antivirus of last generation and we 
have taken the maximum cautions in the development of the program and of the 
installation system, Castor Software is not responsible for losses or damages 
caused by these. We recommend that it maintains backup copies of all their 
fundamental data before installing the CASTOR-ELEC software. 
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FOREWORD 
 
The numeric algorithms that CASTOR-ELEC uses gives us the possibility to study the  electromagnetic 
pollution that we find in our environment. The numerical method uses a equation that estimates the 
dispersion of the electrosmog in the air.  
 
The software admits meteorological data to establish the form of the electromagnetic pollution. The 
software calculates the emission that is produced by each one of the sources and it considers the 
estates of the sources and the state of the atmosphere.  
 
The system of simulation of processes of dispersion that CASTOR-ELEC has, offers to the beginner 
and the expert programmer, a quick and practical system to evaluate the electromagnetic pollution. 
The program is based on the operating system Microsoft WINDOWS where one works intensively with 
the mouse and the graphic windows. The bars of icons facilitate the realization of the different tasks of 
the program. We can say, with a certain security that the software CASTOR-ELEC is one of the best 
tools, to carry out numeric simulations of electromagnetic pollution processes. Without considering the 
experience that the user possesses in programming languages or in the use of simulation tools, in few 
minutes he will be able to have the first results.  
 
This manual will describe the use and the possibilities of CASTOR-ELEC that we will show with the 
use of examples. It is not strictly necessary possessing knowledge on the handling of the operating 
system of Microsoft WINDOWS although it is advisable. Along the user's manual we will simulate 
some electromagnetic  pollution processes whose development will illustrate the use of the program in 
the case of complex systems. We will describe the necessary steps for the study of a electromagnetic 
pollution process with the software.  
 

Finally, we will say that they exist in the scientific literature a great quantity of models to 
evaluate the dispersion of electromagnetic in the air. In this way, we will obtain numeric differences 
among the results of the program and the results of other numeric models. This is not strange since 
there are numeric differences among the different models of the scientific literature.
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1. Introduction 
 
Software for analysis of electromagnetic pollution in 
environment: environmental modeling, environmental impact 
assessment, environmental engineering, environmental 
consultancy service and environment simulation. 
 
CASTOR-ELEC is a electromagnetic pollution modeling software. 
The program calculates the elecromagnetic pollution in each 
point of the air considering each one of the antennas in 
mobile phone towers. The system of simulation of processes of 
pollution that CASTOR-ELEC has, offers to the beginner and the 
expert programmer, a quick and practical system to evaluate 
the pollution in the air. The program is based on the 
operating system Microsoft WINDOWS where one works intensively 
with the mouse and the graphic windows.  We can say, with a 
certain security that the software CASTOR-ELEC is one of the 
best tools, to carry out numeric simulations of 
electromagnetic pollution processes. 
  
CASTOR-ELEC SOFTWARE Solutions: 
 
It is ideal for environmental impact assessments, 
environmental consultancy services and environmental 
engineering. 
 
With this application you will be able to import images and 
pictures (previously saved BMP files) and Google maps. These 
images will be background pictures and images for your program 
window. Many programs and computer applications (AutoCad, 3d 
Studio, ArcView,...) export BMP files. You will be able to 
load pictures and images generated by these programs. 
This software can also be used for risk studies and safety in 
cities. 
 
At the present time, numerous universities and study centers 
use this program for teaching and education. 
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CASTOR-ELEC Software: electromagnetic pollution map with three different antennas in three 
different mobile phone towers. 
  
CASTOR-ELEC SOFTWARE Advantages: 
 
Without considering the experience that the user possesses in 
programming languages or in the use of simulation tools, in 
few minutes he will be able to have the first results.  
With this application you will be able to export your 
simulation results (BMP files). These images will contain the 
background picture (map) and your simulation results. Many 
programs and computer applications (AutoCad, 3d Studio, 
ArcView, MS Power Point, MS Word,... ) can import your saved 
BMP files. 
 
It works in cartesian and geographical coordinates and the 
results can be exported in Microsoft EXCEL csv files. It is 
possible to import the CUSTIC generated data in GIS systems, 
as ArcMap or ArcView. 
It is possible to obtain XY and XZ electromagnetic pollution 
maps. 
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CASTOR-ELEC Software: electromagnetic pollution map with different antennas with a background 
image. 
 
  
  
  
  
  
 
 
 
  
  
  
  
  
  
  
  
  
 
 
 
  
  
  
CASTOR-ELEC Software: electromagnetic pollution map with different antennas with an AutoCAD 
map. 
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CASTOR-ELEC Software: electromagnetic pollution map with different antennas with a background 
image. 
  
 
 
Software characteristics   

·        System requirements: Windows 95, 98, 2000 and XP 
·        CD-ROM drive 
·        RAM Memory: 16MB or higher 

  
 

1.1 Mobile phone towers 
 
 

A cell site is a term used primarily in North America for a 
site where antennas and electronic communications equipment 
are placed to create a cell in a mobile phone network 
(cellular network). A cell site is composed of a tower or 
other elevated structure for mounting antennas, and one or 
more sets of transmitter/receivers transceivers, digital 
signal processors, control electronics, a GPS receiver for 
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timing (for CDMA2000 or IS-95 systems), regular and backup 
electrical power sources, and sheltering. 

 

A synonym for "cell site" is "cell tower", although many cell 
site antennas are mounted on buildings rather than as towers. 
In GSM networks, the technically correct term is Base 
Transceiver Station (BTS), and colloquial British English 
synonyms are "mobile phone mast" or "base station". The term 
"base station site" might better reflect the increasing co-
location of multiple mobile operators, and therefore multiple 
base stations, at a single site. Depending on an operator's 
technology, even a site hosting just a single mobile operator 
may house multiple base stations, each to serve a different 
air interface technology (CDMA or GSM, for example). Preserved 
treescapes can often hide cell towers inside an artificial 
tree or preserved tree. These installations are generally 
referred to as concealed cell sites or stealth cell sites. 

 

Place in the wireless network 

Cell sites are connected via copper facilities, optical fiber, 
or microwave. Copper facilities deliver either T1s or E1s, 
while microwave and optical fiber can offer T3s or Ethernet in 
addition to T1s or E1s. Copper facilities and optical fiber 
are usually provided as part of a service from the incumbent 
telephone company, but microwave is generally self-built by 
the mobile telephone company. Whatever the connection, the 
next elements in the mobile telephone network are Base Station 
Controllers (BSCs) and Radio Network Controllers (RNCs) at the 
mobile telephone switching office (MTSO). The base station 
controller is connected to a telephone switch, which is 
connected to the public switched telephone network (PSTN), 
while the Radio Network Controller handles 3G service, and is 
connected to Serving GPRS Support Node (SGSN), which is in 
turn connected to a data network, a telephone switch, or both. 

 

Cell site range 

The working range of a cell site - the range within which 
mobile devices can connect to it reliably is not a fixed 
figure. It will depend on a number of factors, including 

 The type of signal in use (i.e. the underlying 
technology), similar to the fact that AM radio waves 
reach further than FM radio waves.  

 The transmitter's rated power.  
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 The transmitter's size.  

 The array setup of panels may cause the transmitter to be 
directional or omni-directional.  

 It may also be limited by local geographical or 
regulatory factors and weather conditions.  

Generally, in areas where there are enough cell sites to cover 
a wide area, the range of each one will be set to: 

 Ensure there is enough overlap for "handover" to/from 
other sites (moving the signal for a mobile device from 
one cell site to another, for those technologies that can 
handle it - e.g. making a GSM phone call while in a car 
or train).  

 Ensure that the overlap area is not too large, to 
minimize interference problems with other sites.  

In practice, cell sites are grouped in areas of high 
population density, with the most potential users. Cell phone 
traffic through a single cell mast is limited by the mast's 
capacity; there is a finite number of calls that a mast can 
handle at once. This limitation is another factor affecting 
the spacing of cell mast sites. In suburban areas, masts are 
commonly spaced 1-2 miles apart and in dense urban areas, 
masts may be as close as ¼-½ mile apart. Cell masts always 
reserve part of their available bandwidth for emergency calls. 

 

The maximum range of a mast (where it is not limited by 
interference with other masts nearby) depends on the same 
circumstances. Some technologies, such as GSM, have a fixed 
maximum range of 40km (25 miles), which is imposed by 
technical limitations. CDMA and iDEN have no built-in limit, 
but the limiting factor is really the ability of a low-powered 
personal cell phone to transmit back to the mast. As a rough 
guide, based on a tall mast and flat terrain, it is possible 
to get between 50 to 70 km (30-45 miles). When the terrain is 
hilly, the maximum distance can vary from as little as 
5 kilometres (3.1 mi) to 8 kilometres (5.0 mi). The concept of 
"maximum" range is misleading, however, in a cellular network. 
Cellular networks are designed to create a mass communication 
solution from a limited amount of channels (slices of radio 
frequency spectrum necessary to make one conversation) that 
are licensed to an operator of a cellular service. To overcome 
this limitation, it is necessary to repeat and reuse the same 
channels. Just as a station on a car radio changes to a 
completely different local station when you travel to another 
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city, the same radio channel gets reused on a cell mast only a 
few miles away. To do this, the signal of a cell mast is 
intentionally kept at low power and many cases tilting 
downward to limit its area. The area sometimes needs to be 
limited when a large number of people live, drive or work near 
a particular mast; the range of this mast has to limited so 
that it covers an area small enough not to have to support 
more conversations than the available channels can carry. 

 

A cellphone may not work at times, because it is too far from 
a mast, but it may also not work because the phone is in a 
location where there is interference to the cell phone signal 
from thick building walls, hills or other structures. The 
signals do not need a clear line of sight but the more 
interference will degrade or eliminate reception. Too many 
people may be trying to use the cell mast at the same time, 
e.g. a traffic jam or a sports event, then there will be a 
signal on the phone display but it is blocked from starting a 
new connection. The other limiting factor for cell phones is 
the ability of the cell phone to send a signal from its low 
powered battery to the mast. Some cellphones perform better 
than others under low power or low battery, typically due to 
the ability to send a good signal from the phone to the mast. 

 

The base station controller (a central computer that 
specializes in making phone connections) and the intelligence 
of the cellphone keeps track of and allows the phone to switch 
from one mast to the next during conversation. As the user 
moves towards a mast it picks the strongest signal and 
releases the mast from which the signal has become weaker; 
that channel on that mast becomes available to another user. 

 

Temporary cell sites 
 
 
Cell-on-wheels, or COW 
 

Although cell antennas are normally attached to permanent 
structures, cell providers maintain a fleet of temporary cell 
sites. When mounted on a trailer, they are called a COW or 
Cell On Wheels. These usually include a base station 
controller and a telescoping tower with antennas attached. A 
generator may be included when electrical power isn't 
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available, and an additional backhaul antenna may be mounted 
to link the temporary tower into the network. 

 

COWs are often used at the site of a permanent cell site. 
Floods, fires, terrorism, and other disasters may destroy 
permanent antennas or base stations controllers, and fast 
dispatch of COWs can maintain vital communications during an 
emergency. They are also used in planned outages, such as when 
an antenna site is unavailable due to construction or 
maintenance. Finally, they are often used to augment capacity 
when large number of additional cell phone users are expected. 

BTS raw land type. 

 

Antenna BTS 

Frequency= 900 MHz. (system BTS)  

Frequency=1800 MHz y 1900 MHz (system DCS).  

  

1 microwatts/cm2= 1 uW/cm2 = 0,001 mW/cm2= 0,000001 W/cm2.  

Limits: 

  

Country Frequency (MHz)  Power density (uW/cm^2)  

United Status (USA) - United 
Kingdom 

900 –1.800 570 – 1.000 

European Union (1999)  900 –1.800 450 - 900 

Spain 900 –1.800 450 - 900 

Germany 900 –1.800 200 - 900 

Italy 3 –3.000 100 

China 900 –1.800 6 

Russia 900 –1.800 5 

Switzerland 900 –1.800 4,2 

Salzburgo (Austria)  900 –1.800 0,1 
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2. Commands CASTOR-ELEC  
 

2.1 File 

 
The File Menu contains the tools you use to open, close 

and save new and existing files, and import and export 
graphics. The File Menu lists: New, Open, Save, Import 
Picture, Export Picture, Print, Print Picture and Exit. 

 

New.- This command is to begin a new simulation, deleting all 
that has been made previously.  

 

Save the work with the Save command before clicking the New 
command.  The program doesn't allow to open two files at the same 
time. This way, we can optimize the available memory and the 
calculation speed. 

 

Open.- This command is to open an existing file. The program 
files exist as separate files with .cus filename extension. 

 

Save the current work with the Save command before clicking the 
Open command.  The program doesn't allow to open two files at the 
same time. 

 

Save.- This command is to save an existing result.  

 

The process of saving a file is carried out proportionally to the size 
in which the elements are drawn in the screen. Then, the saved file 
will depend on the screen format that we are using (for example, 
1280x1024,…). If we try to read a file, saved in another different 
computer, we will have problems to open it. 
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Import Picture.- With this command you will be able to import 
images and pictures (previously saved BMP files). These images 
will be background pictures and images for your program 
window. You can display an image by double-clicking the 
filename of a bitmap (BMP). 

 

Many programs and computer applications (AutoCad, 3d Studio, 
ArcView,...) export BMP files. You will be able to load pictures and 
images generated by these programs. 

 

The displayed image size will depend on the size that had when 
it was saved. If it is necessary, modify the picture size 
before loading the image (for example, you can use windows 
Paint, Adobe Photoshop,… ). You will be able to load BMP maps 
generated by AutoCad. 

 

Bitmaps and scanned maps must be loaded into memory and then 
adapted to the program scale (we will make use of the Scale 
command). The X-Axis width (meters) in the program window can 
be easily changed to be able to compare both images 
(simulation results and background maps). Then, the X-Axis 
width (in meters) of the imported map and the X-Axis width (in 
meters) of the program window match together. The imported 
images are not stored physically in the simulation process. 
Terrain elevations (represented on the imported map) don’t 
interact in the simulation process (sound reflections). We 
haven't the possibility to zoom an imported map with the Zoom 
command. This command only acts in the calculation process. If 
it is necessary, zoom  the map before loading the image. 

 

Export Picture.- With this command you will be able to export 
images and pictures (BMP files). These images will contain the 
background picture and the simulation results. 

 

Many programs, computer applications and word processors 
(AutoCad, 3d Studio, ArcView, MS Word,...) import BMP files. You 
will be able to load images generated by CUSTIC. 

 

Print.- The users’ printer drivers and printers impact print 
quality. With this command you can send graphics and text (of 
the simulation results) to a printer. This command provides 
the best printing quality across a variety of printers because 



Castor . 
 

 12 

Windows translate text and graphics from the device-
independent drawing space to the Printer object to best match 
the resolution and abilities of the printer. However, the 
background pictures cannot be printed. 

 

Print image.- This command send a pixel-by-pixel image of the 
program window to the printer. To print with Print image 
command, you must first display that information on the 
program window and then print with this command. This command 
is by far the easiest way to print from your application.  
Because it may send information to the printer at the 
resolution of the user’s screen (typically 96 dots per inch), 
results can be disappointing on printers with much higher 
resolutions (typically 300 dots per inch for laser printers).  

 

Exit.- The Exit command allows you to exit directly from the 
application. 
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2.2 View 
 

The View Menu contains the tools you use to view your 
computer screen. The File Menu lists: Zoom, Black background, 
White background, Draw grid lines, Eliminate grid lines, Draw 
picture, Eliminate picture and XY and XZ view. 

 
Zoom.- We have the possibility to zoom a part of the program 
window with the Zoom command. However, we won't be able to 
enlarge background pictures with this command. If it is 
necessary, zoom the map before loading the background image. 
This command only acts in the calculation process. This way, 
we can place a point source in a side of the computer screen 
and we can calculate the concentrations in another different 
detailed region. 
 
 

 
 
 
To activate the Zoom command, eliminate the background picture 
first. 
 
Black background.- The Black background command allows you to 
have a black background colour in your screen. 
 
White background.- The White background command allows you to 
have a white background colour in your screen. 
 
Draw grid lines.- If you select Draw grid lines command, the 
grid appears. 
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Eliminate grid lines.- If you select Eliminate grid lines 
command, the grid disappears. 
 
Draw picture.-  With this command you will be able to see  
background images and pictures (previously loaded BMP files).  

 
Eliminate picture.- With this command you will eliminate  
background images and pictures (previously loaded BMP files).  
XY and XZ view.- These command are to get views of the XY and 
XZ planes. 
 
 
 

2.3 Antenna 
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Mobile phone tower.- It is for a pollutant source fixed in the 
space and small if we compare with the area  where the 
calculation is done.  

 

 

where we can introduce all the antennas from the mobile phone 
tower that we want simulate. 

 

 

Antenna type: BTS (panel) o DTS (stick and old mobile phone 
system). 

 

Height of the antenna from the ground (m): It is the height 
of the antenna from the ground level (antenna base) and is 
in meters or number of floors (3 meters each floor). 

 

Angle of fall (grads): Only for BTS (panel antenna). This 
type of antenna use to point a place that is located at 50m 
or 200m from the antenna base. A typical value can be 5 or 
20 grads.  

 

Power (Watts ERP): It is the power when the antenna works. 

 

Antenna direction: Only for BTS (panel type). This type of 
antenna uses to point a direction. It can be expressed in 
grads or North (N), East (E), South (S) and West (W) 
directions. 

 

If you click the OK button, the next program window is shown 
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Two blue axis points the place where we can fix the source 
position. After clicking the program window, you draw the 
point source. 
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The small fuchsia square shows the source location. We can 
draw all the noise sources that we want (up to 1,000). To 
change the point source data, we can click the source location 
in the program window. Then, the point source dialogbox is 
again displayed. We are not able to put two noise sources in 
the same location. The older one is eliminated automatically. 

 

 
 
 
 
 
 

 

 

2.4 Environment 
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Topographic lines.- This command is to draw topographical 
lines. If you click this command, the next dialog box is 
shown: 

 

 

 

The height of the contour line can be written in the textbox. 
If you click the Accept button, the next computer screen is 
shown: 
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Then, and if you click the computer screen and move the mouse 
(mouse down), a square is shown and when you mouse up (the 
height of the contour line is different to zero): 
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The area inside this contour has a 10m height. A rectangle 
elevation could be represented by the program in the next way: 
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To draw a small mountain, we can use a lot of small 
rectangles. 

 

 

10m 
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X 
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Castor . 
 

 22 

 

A mountain could be represented by the program in the next 
way: 

 

 

 

 

2.5 Tools 

 
 

The Tools Menu contains the tools you use to process your 
data. The File Menu lists: Delete, Axis scale, XY and XZ 
Calculation, Colour gradient, Isolines, Numerical grid and 
Calculation parameters. When you choose Tools in the Menu bar, 
the program displays: 

  
 
 

X 

Z 
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Delete.- This command is used to delete pollutant sources that 
we don't want in the simulation. If you click the Delete 
button, the next program window is shown: 
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Clicking on these points we will delete them from the screen 
and from the calculation. 

 

Scale.- With this command, we will decide the work area size 
in the simulation process. It is an important tool because 
with their good use we will be able to interpret and to 
extract interesting data of the numeric simulation. The scale 
is defined according to the width in meters that we want to 
associate to the X-Axis of our program window. If you click 
the Scale button, the next program window is shown: 

 

 

 

 

In this window we will be able to choose the number of meters 
that we want to have in the X-Axis. When we have the value 
written in the textbox, we will make click with the mouse on  
Accept button and this value will be modified and the previous 
window will disappear. If we click the Cancel button it closes 
the window without modifying the value. This command will be 
used before using the calculation command, since this 
parameter should be perfectly defined before making the 
simulation. When we use this program command, we clean the 
whole screen of the computer and we lose all the elements of 
the simulation placed previously. If we don't want to lose the 
information obtained until the moment we will use the Save 
command before executing the Scale command. 

 

In certain situations, it can be interesting to have a high 
number of meters in the X-Axis for a better visualization.  
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Calculation (XY and XZ plane).- The calculation commands run 
the necessary algorithm to carry out the numeric simulation. 
We will run the command after having fixed the necessary data 
for the simulation, that is to say, the sources, the ambient 
data, the scale,... If we change any initial data (as the 
position of the source,...),  we will need to run the command 
again so that this is reflected in the result. If we make 
click on XY-Calculation command, we open the following window 
: 

 

 

 

 

 

 

In this window we will be able to choose if we want to carry 
out the calculation in the land surface or to a certain height 
(two options). In the first option, the calculation of the 
noise pollution will be carried out at surface height. If we 
choose the option for the calculation to a certain height, we 
will write in the textbox the plane height in which we will 
obtain the results (0m for the surface of the sea). If we make 
click on XZ-Calculation command, we open the following window: 
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The program works in the following way: while it calculates, the 
machine centers all the capacity of the CPU in the calculation, 
stopping the other tasks of Windows. If we want to stop a tedious 
calculation, we will be able to make it making use of the keys 
CTRL+ALT+DEL.  

 

Colour gradient.- This command is to draw maps of noise 
pollution making use of a colour gradient. It is specially 
useful when the variation of the noise levels is very strong 
in a very short distance. The program takes the maximum value 
of the noise and it assigns to the maximum the red colour. 
Then, the program assigns the different colours to the grade 
of noise pollution in a qualitative way. We will be able to 
obtain the exact values locating the arrow of the mouse on any 
point and looking at the inferior right textbox of the 
program.  

 

Isolines.- This command induces an opposite effect. We will 
use this command with the purpose of obtaining the isolines 
again. This way we will be able to change representation 
easily making use of these last two commands. 

 

Numerical grid.- This command allows us another alternative 
representation of the calculated noise levels. It establishes 
a numerical grid throughout the calculation screen. It is 
specially useful if we load topographical planes, because with 
the other representations there are many images in the screen. 
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If you click the Numerical grid button, the next program 
window is shown: 

 

 

 

 

Calculation parameters.- This command will show us the 
parameters that we have assigned before carrying out the 
calculation. It is convenient their use with the purpose of 
verifying that we have written the parameters correctly.  

 

 

2.6 Options 
 

The Options Menu includes all the elements for the 
numeric configuration of the simulations. We will use these 
commands before using the calculation command because these 
parameters should be perfectly defined before running the 
simulation. The Options Menu lists: Grid size, Number of 
Isolines, Calculation colours, Fonts and Calculation models. 
When you choose Options in the Menu bar, the program displays: 
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Grid size.- The grid size is an important parameter in the 
configuration of the system. We will decide the number of 
calculation points in the grid that we will take to make the 
simulation. As we increase the number of points, the computer 
will take much more time in carrying out the calculation but 
the result will be much more exact. If you click the Grid size 
command, the next program window is shown: 
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In this window we will be able to choose the number of grid 
points (calculation points) that we want to have in the X-
Axis. The number of points to calculate will increase 
quadratically with the number of grid points along the X-Axis 
N, that is to say, it will increase as N2. 

 

To increase the number of grid points produces that the program 
needs much more RAM-memory. If we take such a high number of 
grid points that it overcomes the available memory of the PC, the 
computer will be blocked. 

 

Number of isolines.- This command is an auxiliary tool for 
making the maps of noise pollution. We will decide the number 
of isolines in the screen that we will take to make the 
representation. In certain situations, it can be interesting 
to have a high number of isolines for a better visualization. 
We will use this command before using the calculation command 
because this parameter should be perfectly defined before 
running the simulation. If you click the Number of isolines 
button, the next program window is shown: 
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In this window we will be able to choose the number of 
isolines that we want to have in our computer screen. To 
calculate the lines, the program also considers the maximum 
point as a line. 

To illustrate the use of this command, we will carry out the 
same simulation varying the number of isolines. We will use 
three different number of isolines. Here, the number of 
isolines is 7.  
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Here, the number of isolines is 3. 

 

 

 

Here, the number of isolines is 17. 
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Calculation colours.- By means of this command, we will be 
able to change the colors of the isolines, of the maximum 
point and of the point sources.  

2.7 GIS 
 

In this option it can be found all necessary to work with 
geographical information system.  

 

Coordinates of the origin.- With this command we can choose 
the value for the origin of coordinates. It is initially in 
the left bottom corner of the program window. It is possible 
to work with geographic and Cartesian coordinates. 
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Reference points.- With this command we can decide the 
coordinate values of a point, that we previously know, in the 
map in order to have a referenced system. It is possible to 
work with geographical and Cartesian coordinates. Once you 
have introduced the desired coordinates, you make ‘click’ in 
the point of the screen where you want to situate the 
reference. In this point will appear red marker. After that, 
it will be possible to export the results to a GIS system.  

 

 

  

 

 

  

 

 

 

 

 

 

 

 

 

 

Radius of curvature.- By means of this command, you can choose 
a value for the Earth radius. This radius can be slightly 
modified to adjust the reference system with the available 
data. The program considers the Earth as a perfect sphere with 
an exact radius. We know that this is not exactly true. This 
option is to correct this kind of effects.  
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Scale calculation.- With this command it is possible to 
estimate the map scale that corresponds to a background image, 
that has trees previously imported by the user. It is 
necessary to know the distance between to different points in 
the map. After introducing the distance data, you can click 
consecutively both points, and the scale will be automatically 
calculated. 

 
  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Export maximum, concentrations,….- These are to export the 
different elements of the programs (isolines, source 
positions,…) to Microsoft EXCEL csv file. To import without 
problems with Arcview we have used the english format system 
for the numbers. For example, one euro and 30 cents is 1.30 
euros (NOT 1,30!) in the english format.  
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If you are using the spanish format, when you open the 
exported file with EXCEL you obtain “al numbers in the same 
box”. In such a case, the best way is to change your number 
format in your computer. It is very easy. Just go to WINDOWS 
>> START >> CONTROL PANEL >> REGIONAL CONFIGURATION and look 
for english format before opening with your EXCEL program. 
 
 
 
 

3. Application structure 
 

 

In this section, the general structure of the application 
will be shown. The Options Menu includes all the elements for 
the numeric configuration of the simulations. We will use 
these commands before using the calculation command because 
these parameters should be perfectly defined before running 
the simulation. 

 

 If we change any initial data (as the position of the 
source, air temperature,...),  we will need to run the command 
again so that this is reflected in the result. We will be able 
to choose Calculation command to obtain different pollution 
maps.  
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Colour gradient, Isolines and Numerical grid commands should 
be applied after running the calculation. 

 

 
 

  

  

 

 

 
Scale 

 
Grid size 

 
Ambient data 

 
Calculation 
parameters 

 
Sorces 

 
 

Calculation 

 
Colour gradient 
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